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What’s New in
Chief Architect X12

Welcome to Chief Architect X12. This guide has been written to help our upgrading customers make a smooth 
transition from earlier versions of Chief Architect to Chief Architect X12. 
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Getting Started Checklist
There are many new features in Chief Architect X12, and many existing features have changed. The following 
checklist suggests steps you should take before migrating your files to Chief Architect X12. More information 
about each of these steps can be found after the checklist.

1. Review the List of New and Improved Features

There are a number of important reasons why you should familiarize yourself with the new and improved 
features in Chief Architect X12:

• New and improved features allow you to produce drawings more efficiently, so it is to your advantage to 
use them. 

• Some changes to existing functionality may affect your accustomed drawing style and thus your productiv-
ity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your preferred Preferences 
settings. 

See "New and Improved Features" on page 9. 

2. Review the Considerations for Migrating Legacy Content

Legacy users of Chief Architect often have library catalogs and other custom content that they want to continue 
using. See "Considerations for Migrating Legacy Content" on page 2. 

3. Review the Considerations for Migrating Legacy Settings

Before migrating Preferences, Toolbars, or Hotkeys, bear in mind that legacy settings may not be best suited 
for using the new program version. See "Considerations for Migrating Legacy Settings" on page 3. 
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4. Review the Considerations for Migrating Legacy Templates

Before migrating Templates, bear in mind that they may not be set up to take advantage of new tools in the new 
program version. See "Considerations for Migrating Legacy Templates" on page 3.

5. Review the Considerations for Legacy Files

Before opening a plan or layout file created in a previous version of Chief Architect, be aware of potential 
changes to the file that could occur in the new program version. See "Considerations for Legacy Files" on page 
3.

6. Launch Chief Architect X12.

Once you have learned about the new features in Version X12 and decided whether to migrate any custom 
settings from a legacy program version, launch Chief Architect X12. The first time you launch, the Migrate 
Settings dialog will give you the opportunity to bring legacy settings and content forward into Version X12.

Considerations for Migrating Legacy Content
Legacy users of Chief Architect often have a wealth of library catalogs and other custom content that they have 
built over time and want to continue using. 

Legacy Library Content
There are several ways that legacy library catalogs can be brought into Chief Architect X12. 

If you have Chief Architect version X5 through X11 installed on your computer, the Migrate Settings dialog 
will display after you activate the license, allowing you to migrate library content as well as a selection of other 
settings for use in Chief Architect X12. If multiple legacy versions are present on the system, only the data 
associated with the most recent will be migrated. 

You can import library files from versions X1 through X5 at any time by selecting Library> Import Library 
(.calib, .calibz) from the program menu. 

In addition, library files from versions 10 and prior can be imported by selecting Library> Convert Legacy 
(.alb) Library Files from the program menu.

Custom Graphics Files
Chief Architect can use graphics files regardless of where they are stored on your system; however, it is a good 
idea to keep your data organized in one location. If you have custom graphics files, including textures, images 
or backdrops that you used in a previous program version, you can copy them manually using your operating 
system for use in Chief Architect X12. 

• Copy custom texture files to the Chief Architect X12 Textures folder located in the Chief Architect X12
Data folder.

• Copy custom image files to your Chief Architect X12 Images folder located in the Chief Architect X12
Data folder.

• Copy custom backdrop files to your Chief Architect X12 Backdrops folder located in the Chief Architect
X12 Data folder.

In Chief Architect X11 through X1, custom graphics were saved in the Chief Architect Data folder, as they are 
in version X12. In version 10, they were located in the program’s installation directory, in folders that began 
with “My”. Custom backdrops, for example, were saved in “My Backdrops”. 

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image 
objects, however, which are stored in the library so it is important to retain them.
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Considerations for Migrating Legacy Settings
The Migrate Settings dialog lets you migrate settings from the most recent legacy installation of Chief 
Architect into Version X12. If you have extensively customized your Preferences, Toolbars, or Hotkeys, you 
may want to continue using those settings. Before doing so, though, it is important to consider that you may 
make it harder to take advantage of new tools and functionality in Version X12.

Preferences Settings 
Although you can migrate your Preferences settings from Versions X5 through X11 into Version X12, the 
settings that are available in Version X12 may differ from previous program versions. You should review all the 
settings in the Preferences dialog to make sure that they are set to suit your drawing needs.

Custom Toolbar Configurations
It is possible to migrate toolbar configuration files from previous versions to Chief Architect X12; however, it 
is also possible that your migrated toolbars will be missing new tools available in Version X12. 

We recommend that you set up your custom toolbars the way you would like them in Chief Architect X12. You 
may find it most effective to customize your toolbars as you get used to working in the new program version, 
rather than beforehand.  

Custom Hotkeys
Like toolbar configurations, legacy hotkeys can be migrated into Chief Architect X12. Bear in mind, though, 
that occasionally the default hotkeys are modified to accommodate new features or changes in default system 
hotkeys. 

Considerations for Migrating Legacy Templates
Chief Architect X12 installs a selection of template plan and layout files that have been set up to take 
advantage of the program’s updated tools and features. Although you can migrate your template files for use in 
Version X12, for best results it is recommended that you either: 

• Use the installed templates when creating new plans and layout files in Chief Architect X12
• Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program version, it is very 
important that you take the time to carefully review all the default settings in the file, making sure that they will 
continue to suit your needs in X12. First, make copies of your custom templates in the Chief Architect X12 
Templates directory The Templates directory is located in the Chief Architect X12 Data folder. Next, open each 
template as you would a regular plan or layout file, by selecting File> Open, and then save any changes you 
make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template from 
the same program version, as well. As with a template plan, take the time to go through the layout template’s 
defaults and make sure they are suited for use in X12 and that their line weight scales do not conflict with those 
in your template plans.

Considerations for Legacy Files
As in all software, every new program version introduces changes to its functionality as well as to the user 
interface. If you choose to bring a project forward, be sure to take a few moments to look it over in the new 
version and confirm that the new functionality does not require you to make any modifications. Particularly if 
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you have an approaching deadline, you may find it best to finish the current project in the version of the 
software in which you began it. 

Chief Architect X12 can open the .plan and .layout files from prior versions. Files with the older .pl and .la file 
extensions are no longer supported, however, and cannot be opened by Chief Architect X12. Before opening 
any files created in earlier versions of Chief Architect, it is important to be aware of changes made in the 
newest version and the effect they may have on your legacy plan and layout files. 

Please note that files saved in the latest program version cannot be read by older versions of the software. 
When a legacy file is saved in the version X12, an unaltered copy of the original file is created in the Chief 
Architect X12 Data folder, under Archives, which can still be opened in the original version.

• "For Files Created in Version X10 and Prior" on page 4
• "For Files Created in Version X8 and Prior" on page 6
• "For Files Created in Version X7 and Prior" on page 6
• "For Files Created in Version X6 and Prior" on page 6
• "For Files Created in Version X5 and Prior" on page 6
• "For Files Created in Version X4 and Prior" on page 7
• "For Files Created in Version X3 and Prior" on page 8
• "For Files Created in Version X2 and Prior" on page 8

For Files Created in Version X11 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X11 or 
prior, bear in mind the following:

1. Perspective Crop Mode

In Chief Architect X8 through X11, Perspective Crop Mode allowed older functionality governing zooming in 
cameras from Version X7 and prior to be preserved in saved cameras in legacy plans migrated forward. This 
deprecated tool has been removed from the program’s menu and toolbars in Version X12, although it can be 
migrated with legacy toolbars and hotkeys. Saved cameras in legacy plans with this behavior enabled may 
become distorted if you pan or zoom in the view. To permanently disable this behavior in a camera view and 
resolve the resulting distortion, select Window> Fill Window or press the F6 key.

2. Layout Layer Sets

In Chief Architect X11 and prior, the Send to Layout dialog had a sticky Make Copy of Active Layer Set option 
that created a new layer set for the layout view to help preserve layer settings in that view. This option was 
removed in Version X12 to encourage use of the multiple saved plan views. Saved plan views did not exist in 
Version X9 and prior, however, so if you open a plan originally created in Version X9 or prior, extra care must 
be taken to make sure layout views do not use the same layer set.

3. Materials List Formulas and Ruby Macros

 Name-Value Pairs returned length, area, and volume measurements as Floats. In Version X12, these values are 
reported using the Measurement class that includes both a numeric value and a unit. Older Ruby code may 
change behavior when migrated into Version X12. When a legacy Ruby macro or materials list formula is 
evaluated, the program will automatically check its version and prompt you to migrate it to the newest version.

For Files Created in Version X10 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X10 or 
prior, bear in mind the following:

1. Marker and Elevation Point Heights

In Chief Architect X10 and prior, the # sign could be added to the label of a Marker or Elevation Point and the 
label would report the height of the Marker or the Elevation Point’s elevation. In Version X12, text macros are 
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used to report this information instead. In legacy plans, any # signs in Marker or Elevation Point labels will be 
replaced by the %heightf% or %elevationf% macro.

2. Glass Shower Walls

In Chief Architect X10 and prior, the “Glass Shower” wall type was included in installed template files and like 
other wall types, built to the structural layer of floors and ceilings and to the Main Layer of adjacent walls. In 
Version X12, this wall type has the new Partition Wall attribute and instead builds to floor, ceiling, and wall 
surfaces. When a legacy file is opened in Version X12, this wall type will be modified to have Partition Wall 
checked automatically and existing walls will be affected by this change.

3. Fixture Schedules

In Chief Architect X10 and prior, 3D Elevations and Perspectives in Fixture Schedules showed cabinet fixtures 
inserted into a cabinet. In Version X12, fixtures are shown on their own, even when they are inserted into an 
object in the plan. When a legacy file is opened in Version X12, any fixture schedules showing 3D views of 
objects may be affected by this change.

For Files Created in Version X9 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X9 or 
prior, bear in mind the following:

1. Parallel Lights

In Chief Architect X9 and prior, Parallel Light sources could be specified for electrical light fixtures and Added 
Lights. In Version X12, Parallel Lights are no longer supported. In legacy plans opened in Version X12, any 
Parallel Light sources will be converted to Spot Lights.

2. Brick Ledges

In Chief Architect X9 and prior, brick ledges were not represented in floor plan view. In Version X12, brick 
ledges are drawn in plan view on the “Slabs” layer in stem wall and grade beam foundations, and on the “Walls, 
Foundation” layer in monolithic slab foundations. When a legacy file is opened in Version X12, brick ledges, if 
present, will be drawn.

3. Window Types

In Chief Architect X9 and prior, the %type% text macro for windows reported some Window Types using 
abbreviations. In Version X12, the abbreviations were replaced with full words. When a legacy file is opened in 
Version X12, the width of Window Schedules may be affected, as may the width of columns in saved Materials 
Lists.

4. Joist Direction Lines

In Chief Architect X9 and prior, Joist Direction Lines described all platform framing as “joists” and used 
nominal lumber sizes in whole inches in US Unit plans. In Version X12, the platform’s framing Structure Type 
is reported and in US Unit plans, the size is described in fractional inches. When a legacy file is opened in 
Version X12, Joist Direction Lines will use the new, more accurate labeling.

5. Custom Schedule Columns

In Chief Architect X9 and prior, custom schedule columns could be created by adding a Sub Category to a type 
of object on the Categories panel of the Preferences dialog. In Version X12, Sub Categories can no longer be 
created in this manner. When a legacy file is opened in Version X12, any Sub Categories shown as custom 
schedule columns will be converted to Custom Fields.

6. Registered User Text Macros

In Chief Architect X9 and prior, a selection of Registered User Text Macros could be inserted into Texts, 
Callouts, and Markers. These macros no longer displayed any data and in Version X12, they are no longer 
recognized. When a legacy file is opened in Version X12, any Registered User macros inserted into text objects 
are treated as regular text.
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For Files Created in Version X8 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X8 or 
prior, bear in mind the following: 

1. Layer Names

In Chief Architect X8 and prior, turning off the Modify Name in all Layer Sets option made it possible to 
assign different names to the same layer in different layer sets. In Version X9, this option was no longer 
supported. When a legacy file is opened in X12, the layer names used in the currently active layer set will be 
retained and any other layer names in other layer sets will be discarded.

For Files Created in Version X7 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X7 or 
prior, bear in mind the following:

1. Boxed Eaves

In Chief Architect X8, improvements to the generation of Boxed Eaves ensure that they extend into exterior 
rooms with “Use Soffit Surface for Ceiling” specified when located between the roof baseline and an interior 
room. In some legacy plans opened in Version X12, the Length value for Boxed Eaves may need to be 
modified in the Roof Plane Specification dialog.

2. Uppercase Text

The Uppercase option was added to Text Styles in Version X8, whereas in Version X7 and prior, it was an 
option for Room Labels and Schedules only. In legacy plans opened in Version X8, any Schedules present in 
the drawing will be assigned a Custom Text Style, as will their associated Schedule Defaults. If any Schedule 
Default is set to Use Layer for Text Style and no objects are present on that layer, a new Schedule Text Style 
will be created and assigned to that layer. Room Labels are treated similarly: if any are present, they and their 
defaults will use a Custom Text Style. If a given Room Label or Schedule has been sent to layout more than 
once and was set to use different Text Styles in each layout view, it is possible that its appearance may be 
affected in some views.

For Files Created in Version X6 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X6 or 
prior, bear in mind the following:

1. Built-in Appliances

In Chief Architect X6 and prior, some appliance symbols designed to be inserted into base cabinets had 
incorrect sizing data. In legacy plans opened in Version X12, these appliances will not fit into the cabinet 
correctly and will need to be replaced. Built-in dishwashers are particularly affected.

2. Formatting of Bulleted and Numbered Lists

In Version X7, various improvements were made to the way lines of Rich Text are spaced. In legacy plans 
opened in Version X7, Rich Text objects with bulleted and numbered lists may require adjustments.

3. Chief Blueprint Font

The Chief Blueprint font was improved for Version X6, with decreased top and bottom spacing. The change in 
spacing may increase the overall height of text objects using this font in X6 files opened in Version X12. X5 
and prior legacy files will not be affected by this change.

For Files Created in Version X5 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X5 or 
prior, bear in mind the following:

1. Name-Value Pairs for Doors and Windows
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In Version X6, the NVPs door_style_name, door_type_name, and window_type_name were shortened to 
style_name and type_name. Any object labels or text macros using these NVPs in legacy plans opened in 
Version X12 will need to be replaced.

For Files Created in Version X4 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X4 or 
prior, bear in mind the following:

1. Roof Overhangs and Framing

In Chief Architect X4 and prior, roof overhangs were measured to the outside of the subfascia, whereas in 
Version X5 and later, they are measured to the outside of the fascia or shadow boards, if present. In legacy 
plans opened in Version X12, this will not affect the appearance of roof planes in floor plan view because in X4 
and prior, roof plane polylines represented the projected framing area whereas in Version X12 they represent 
the total projected area. But, the position of the fascia and subfascia will shift, as will the length of the rafters.

2. Door Swing Direction and Materials

In Chief Architect X4 and prior, exterior doors that swing outward display interior material on exterior side of 
door. This was corrected in Version X12. Doors modified to work around the old behavior could be affected in 
legacy plans opened in Version X5.

3. Door Swing Direction and Louvers

Improvements to door louver direction may affect louvers in all doors with the exception of bifold doors.

4. Wrapped Door/Window Lintels and Window Sills

In Chief Architect X4 and prior, wrapped lintels and sills extended out further than those that were not 
wrapped. In legacy plans opened in Version X12, the extents of wrapped lintels and sills will be adjusted so that 
they equal their Extend setting.

5. Cabinet Feet

The offsets for cabinet foot millwork symbols in Version X4 and prior were set per millwork symbol to insert 
into cabinets effectively. In Version X12, the offset is set in the Cabinet Specification dialogs. When legacy 
plans are opened in Version X5, cabinet foot offsets are set to 0 and transferred to their containing cabinet, if 
one exists. Any customized or independently placed cabinet feet will be affected.

6. Object Labels in Cross Section/Elevation Views

If a “Label” layer is turned on in a cross section/elevation view and objects of that type are visible in the view, 
then those objects’ labels will display in that view when the plan is opened in Version X12.

7. Transparent Materials

In Chief Architect X4, materials assigned to the Transparent Material Class for ray tracing were visible in 
rendered views even when their Index of Refraction was set to 1.0. When legacy plans are opened in Version 
X12, Transparent materials with an Index of Refraction of 1.0 are transferred to the General Material class and 
assigned a Transparency value of 100%. This will not affect these materials’ appearance in ray trace views, but 
will make them completely invisible in rendered views.

8. Registered User Text Macros

In Chief Architect X4 and prior, a selection of Registered User Text Macros could be inserted into Texts, 
Callouts, and Markers. These macros reported information that was provided when the program was installed 
and registered on the computer. In Version X5 and later, the program no longer collects registered user 
information. When a legacy file is opened in Version X12, any Registered User macros inserted into text 
objects are treated as regular text.

9. Invisible Beams

The legacy Invisible Beam check box was removed from the Wall Specification dialog. When legacy plans 
are opened in Version X12, any Invisible Beam walls will be converted to Invisible Walls. 
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For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or 
prior, bear in mind the following:

1. Text Styles

The appearance of a number of objects that include text - including object labels, the North Pointer, Sun 
Angles, Joist Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text 
Style. Their appearance may be altered somewhat in legacy plans opened in Chief Architect X12.

2. Light Sources

The illumination created by light fixtures and Added Lights was improved in Chief Architect X12. Lighting in 
legacy plans may appear noticeably brighter when viewed in version X12.

For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file 
management changes and structural enhancements:

1. Legacy file formats

Chief Architect 9.5 and prior files were saved in  .pl and .la the file formats. These file formats files are no 
longer supported and cannot be opened in version X12. 

2. Material textures, images, and backdrops

Chief Architect X2 and prior installed with a catalog of library content, including a selection of material 
textures, images, and backdrops. This library catalog is no longer installed with the program because it is now 
available for download on-demand, so it will be possible to open a legacy plan in version X12 and encounter 
numerous missing file warnings. To avoid this, we recommend using the Export Entire Plan feature in the 
original program version to create a folder that includes the plan and all associated textures, images, and 
backdrops before opening this file in X12. This tool is renamed Backup Entire Plan in version X12.

3. Floor and ceiling finish thicknesses

In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as 
railings, stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the 
subfloor. These objects now measure their Floor to Bottom height from the floor finish surface by default, so it 
is possible that you may notice height changes for these objects - particularly in saved, annotated cross section/
elevation views.

4. Riser heights and landing thicknesses

The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) 
in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X12.

5. Auto Adjust Height

The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height check box. If 
a cabinet, fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or 
prior and was located in a room with a floor height other than the default for the current floor, then the object’s 
Floor to Bottom Height will change to equal that room’s floor height. The object’s position in the model will 
not change, however. 

6. Adjustable Thickness Walls

In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file 
is opened in version X12 and these wall types are detected, they are replaced by an updated, non-generic wall 
type. Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side.
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7. Stairwells defined by railings

Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers 
of sheetrock when the plan is opened in version X12. This can affect the appearance of staircases where they 
join to a floor platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top 
edge of the staircase. 

8. Deck rooms

In legacy plans opened in Chief Architect X12, Deck rooms with Advanced Deck Framing built retain the 
framing but have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built 
are converted to Balcony rooms.

9. Material definitions and light sources

Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The 
Ambient setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when 
opened in version X12. 

The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft 
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans 
is capped at 4” (100 mm).

10. Structural Member Reporting

When a plan created in Chief Architect X2 or prior is opened in Chief Architect X12, Materials Lists are set to 
calculate Total Lineal Length. For a combination of lineal length and piece count, select Mixed Reporting in 
the Structural Member Reporting dialog.

11. Fill New Framing Members

In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X12 it 
applies to the entire plan. As a result, it is turned off by default in legacy plans opened in version X12.

New and Improved Features
The following is a list of new and improved features 
in Chief Architect Version X12.

Installation
• City Blueprint and Country Blueprint fonts are no

longer installed with Chief Architect.

Program Overview

• New Crosshairs  toggle button.
• The Status Bar now displays a description of a

tool both when the mouse pointer is highlighting
it and when it is active.

Project Management
• Schedules are now listed in the Project Browser.
• Files and views can now be saved using the con-

textual menu in the Project Browser.

Preferences and Default Settings
• Annotation Sets have been renamed Default

Sets.
• Revision Clouds are now included in Default

Sets.

• The Save as Template  tool now has options
for purging data from a file.

• The Active Defaults dialog now states the name
of the currently active view in its title bar and has
a Rename option for saved defaults.

• New Reset Migration option allows you to be
reprompted to migrate contents and settings from
an older program version.

View and Window Tools
• The reorganized Saved Plan View Specification

dialog how has three panels.
• New Save options in the Saved Plan View

Specification dialog let you control if and when
changes to the view are saved.



10

Chief Architect X12 Migration Guide

• New Link to Layout option in the Saved Plan
View Specification dialog.

• The Aerial View side window has been removed
from the program.

Creating Objects
• The Copy and Paste in Place edit tool has been

replaced by the Paste Hold Position  edit
tool.

Displaying Objects
• The background color and transparency for fill

patterns can now be specified.

• New Style Palette  tool lets you apply whole
sets of attributes to multiple objects to quickly
change the look of a room.

• New Reset Layer Names and Delete Unused
Layers options in the Layer Display Options
dialog.

• Obsolete settings for camera views were removed 
from the Layer Set Defaults dialog.

Editing Objects

• New Point to Point Center  edit tool lets you
quickly center an object between two points.

• The Break Line edit tool has been renamed

Break .
• Improved feedback using the Point to Point

Move  edit tool.
• New Layer Options for Converted Polyline in

the Convert Polyline dialog.
• Improved granularity of object categories in the

Delete Objects dialog. Walls, cameras, Added
Lights and additional framing objects can now be
deleted, as well.

• The new Marquee Mode  for the Style Pal-
ette Painter, Fill Style Painter, and Object Painter
lets you apply attributes to objects by drawing a
marquee around them instead of clicking on
them.

• The Trim Object(s)  and Extend Object(s)
edit tools are now available for elevation

lines and polylines.

• An existing CAD Detail can now be copied.

Walls, Railings, and Fencing
• New Delete All Unused option lets you remove

all unused wall types from the current plan.

• The Break  edit tool has replaced the Break
Wall tool.

• New setting in the General Wall Defaults dialog
lets you turn off the Auto Reverse Wall Layers
behavior.

Rooms
• New tools for creating Trey Ceilings.
• New Calculate Structural Materials for Deck

 edit button for Deck rooms.
• COMPONENTS and SCHEDULE panels have been

added to the Room Specification dialog.
• Moldings can now be specified in the Room

Type Defaults dialogs.
• Crown moldings are now offset from the ceiling

rather than the floor.

Dimensions
• New Add Segments edit handles allow you to

increase the length of a dimension line and locate
additional objects at the same time.

• New Suppress Dimension Value option lets you
completely replace the information in a dimen-
sion line label.

• New Mark as Centerline  and Remove Cen-
terline Mark  edit tools are available for a
selected extension line.

Text, Callouts, and Markers
• Improved interface in the Find/Replace Text and

Check Spelling dialogs.
• New “Selected Objects” scope in the Find/

Replace Text dialog.
• Improved ability to search for % character using

the Find/Replace Text tool.
• The deprecated Special Use option for lines with

arrows has been removed from the program.

Doors and Windows
• New “Match Interior” option for exterior door

handles and locks.
• New Box Header option produces horizontal top

and bottom header rails.
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• Panel door top rail and side stiles can now be
specified separately to produce offset lites.

• The Automatic behavior governing door and
window Header Type is both improved and now
optional, allowing you to specify any header
type, regardless of the wall’s Main Layer mate-
rial.

• New All Glass option for Glass Panel garage
doors.

• Mulled units with Treat as Door specified are
now placed on the “Doors” layer.

• A window’s sash can now be suppressed by
unchecking a box.

• Windows can now be positioned in a corner using
the end Resize handles.

• Nested CAD blocks can no longer be used when
creating Custom Muntins.

Cabinets

• New Add Waterfall to Selected Edge  edit
tool for Custom Countertops.

• The Reverse Appliance option now applies to
individual appliances inserted into a cabinet
instead of all appliances in that cabinet.

• Top-mounted appliances and fixtures can now be
selected, offset, and reversed in the Cabinet
Specification dialog.

• The interior material for cabinet boxes can now
be specified independent of the exterior box
material.

• Countertops, backsplashes, and toe kicks can
each be suppressed on an individual cabinet by
unchecking a box.

Schedules and Object Labels
• New Custom Schedule Categories.
• Schedules can now be set to include multiple

objects types.
• Objects can now be assigned to categories other

than their initial system category, as well as
assigned to multiple categories.

• The Additional Text settings for Automatic
labels were moved from the Schedule
Specification dialog to the LABEL panel of appli-
cable objects’ specification dialogs.

• The OBJECT INFORMATION and SCHEDULE panels
have been added to the specification dialogs for a
variety of objects.

• New Include Leading Zeroes option for sched-
ule callout labels.

• The deprecated Show Labels check box was
removed from the Schedule Specification dia-
log.

Stairs, Ramps, and Landings
• New Stringer options for Stairs.

• The Break  edit tool is now available for
stairs and ramps.

• The Disconnect Edge  edit tool is now avail-
able for stairs and ramps.

• L and U Shaped Stairs can now be created with
multiple landings.

• Connected stair sections can now have different
widths.

• Merged stair or ramp sections now move along
with a selected landing when it is moved. To
move landings and/or merged stair sections sepa-
rately, hold down the Alt key.

• Stairs now bump into landings and other stairs
when moved.

Roofs
• New structural diagram in the Roof Plane

Specification dialog illustrates the location of
the Height/Pitch Lock point as well as the
selected setting.

• The COMPONENTS panel has been added to the
Roof Plane, Ceiling Plane, and Roof Hole/
Skylight Specification dialogs.

• The Make Roof Baseline Polylines check box is
no longer active when Build Roof Planes is
checked in the Build Roof dialog.

• A preview of the Default Ridge Cap profile now
displays on the RIDGE CAPS panel.

• The deprecated Change Roof Pitch or Height dia-
log has been removed from the program.

Framing
• New Framing Groups produce separate floor

and ceiling platforms for rooms in as-built and
addition areas.

• New Build Framing for Selected Object(s)
edit tool generates floor framing room a selected
room.
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• The Fill Style for a header can now be specified
for plan view as well as Wall Details.

• The COMPONENTS, OBJECT INFORMATION, and
SCHEDULE panels were added to the Framing
Specification dialog.

Trusses
• The COMPONENTS, OBJECT INFORMATION, and

SCHEDULE panels were added to the Truss
Specification dialogs.

Trim and Moldings
• New Auto Offset option for moldings assigned

to objects.
• New Rotate Profile option for molding profiles

assigned to objects.
• New Make Copy option for moldings assigned

to objects.
• The Molding Polyline and 3D Molding Polyline

Specification dialogs now have the COMPO-
NENTS panel.

The Library

• New Find Original in Library  edit tool lets
you select an object in your plan and find it in the
library.

• The Select Library Object dialog now opens to
the location of the selected object when the

Replace from Library  tool is used.

Custom Symbols
• Symbols can no longer be assigned to a “Cabi-

net” category when imported into the program.
• The Symbol Name can now be specified in the

Convert to Symbol dialog.
• The Default Light Offset setting was removed

from the Symbol Specification dialog for sym-
bols as they were imported.

Architectural Blocks

• The Add to Library As  edit tool is now
available for architectural blocks.

Other Objects
• The shapes of Polyline Solid and 3D Box edges

are now editable in all views.

3D Views
• New Display Openings Independent of Walls

and Roofs option lets you display doors, win-
dows, and skylights in 3D views when their con-
taining wall or roof is not shown: for example, in
Framing Overviews.

• New Hide Camera-Facing Exterior Walls
option allows you to view the interior rooms of a
structure while rotating around the exterior.

• Views can now be navigated using a gamepad.
• Camera and cross section/elevation views now

have Selected Defaults settings in their specifi-
cation dialogs.

• The Camera Bumps Off Walls setting is now
off by default in installed template files.

• The deprecated Perspective Crop Mode has been
removed from the program’s menu and toolbars.

• New options for updating lighting both automati-
cally and on demand.

3D Rendering and Ray Tracing
• New Light Sources options let you specify a

Light Set for use in ray tracing.

Pictures, Images, and Walkthroughs

• The Point to Point Resize  edit tool now has
a Retain Aspect Ratio option.

• Improved feedback using the Point to Point
Resize  edit tool.

Importing and Exporting
• Added support for AutoCAD® 2018/2019/2020

file import and export.

Plants and Sprinklers
• The COMPONENTS panel is now available in the

specification dialog for Sprinkler Lines  and

Sprinkler Splines .

Materials List

• Improved Materials List Polylines  can now
calculate materials for multiple floors and have
labels.

• Materials List Polylines  and Calculate
from Area  marquees now have a defaults
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dialog.
• A saved Materials List can now be copied.

Layout
• Multiple Layout files can now be open simultane-

ously.
• The Make Copy of Active Layer Set option in the

Send to Layout dialog has been replaced by the
new Link Saved Plan View check box.

• Layout pages can now be duplicated.

• The obsolete Show Layout tool was removed
from the program.

• The deprecated Merge Generated Lines setting
was removed from the Send to Layout dialog.

Ruby in Chief Architect
• New Ruby Measurements and NumberFormatter

classes.
• New Name-Value Pairs for cabinets, doors and

windows.
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